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MANUAL FOR ANALYSIS & DESIGN USING ETABS 

Objective: 

The primary objective of this document is to make sure that ETABS is used consistently by the structural 
engineers in Atkins office in Dubai in terms of: 

• modelling and analysis procedures 
• use of applicable built-in international codes 
• And complying with local authorities specific requirements. 

This document is intended to complement the ETABS manuals and other relevant technical papers published 
by CSI. It is assumed that the user of this manual has a good command of ETABS and is familiar with the 
following codes: 

• UBC 97 seismic provisions 
• ASCE 7 provisions for wind loading 
• BS codes of practice 

Local Authority specific requirements are covered in Appendices at the end of this document. 

The procedures in this document are based on standard practice in Dubai. However, for specific projects, some 
parameters or procedures need to be revised. This shall be done in accordance with the design statement and 
in conjunction with the project lead engineer. 
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1. File Menu 
1. 1 Open a pre-defined Template 

To ensure that a consistent procedure is adopted for modelling in ETABS throughout ATKINS Dubai, 
two templates are prepared and stored in the Structural Models network drive (U-drive): 

1) JAFZA.EDB 
2) DMTECOM.EDB 

These templates are based on the requirements of local authorities; JAZFA and DM/Tecom 
respectively. These templates incorporate as many of the requirements as possible, however it 
should be noted that many of the local authorities requirements may only be implemented while a 3D 
model is developed, therefore a thorough review during modelling is essential to ensure that these 
provisions are properly taken into account. 

HB-The metric unit is used for ATKINS office in Dubai where the force unit is kilo-Newton (kN) and 
the length is expressed in meters (m). These units are used in the templates. 

1.2 Import geometry 
1.2. 1 Import . DXF file of Architectural grid 

To ensure that the architectural grid is appropriately imported in ETABS, make sure that the DXF 
layer names are consistent with the architectural grid you need to import. 

A form appears that has drop-down boxes associated with ET ABS elements such as beams, 
walls, floors and the like. Use the drop-down boxes to select the DXF layer names that contains 
the lines and insertion points in the DXF file as the ET ABS corresponding elements. Select the 
layer names to be imported by highlighting them. ETABS then imports the lines from any layer in 
the DXF file as ETABS grid lines and imports the insertion point of any block as an ETABS 
reference line. 

1.2.2 Import. DXF floor Plan 

Import the floor plan from a DXF file as follows: 

To ensure an accurate geometric modelling in ETABS, it is recommended that the structural 
floor plan is used as far as possible. Make sure that appropriate layers are selected to be 
imported. 

Note1: ETABS will import 3-d Face and Polyline entities in the DXF drawing as floors or 
openings and line entities as beams/columns. 

Note 2: Use the Story Level Combo box to select the plan location/story level of the entities to be 
imported from the DXF file into ETABS. 

Note 3: The following procedure may be used to create a .DXF file for the model from the 
Architectural AutoCAD floor plan: 

a) Create a layer" ETABS-TYP" 
b) Draw lines along the floor extent 
c) Draw diagonal lines for columns 
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d) Draw centerlines for shear walls 
e) Draw centerlines of transfer / lateral beams 
f) Draw X-V axis to represent origin in ETABS (geometric center of floor) 
g) Save drawings as *.DXF file 
h) Import *.DXF file in ETABS as outlines above. 

1.2.3 Import. DXF file of 3D model 

This option may be used when a 3-D model is available in DXF format. Since 3-D representation is 
not used for typical floor plan and elevation in Atkins Dubai, this option will not be covered in this 
manual. The user may refer to ET ABS manual for further reference. 
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2. Material Properties 
2. 1 Concrete 
2. 1. 1 Define Concrete Grade 

The following concrete grades are often used in ATKINS Dubai: C45, C50, C60 & C70.These 
grades are already pre-defined in ETABS template files.Use of other grades may be justified 
based on project's specific requirements. Use the Define menu> Material Properties command to 
access the Define Materials form. Use that form to add, modify, or delete material properties. 

2. 1.2 Define Concrete mass and weight per unit volume 

The concrete mass and weight per unit volume are taken as 2.54 Ton/m3 and 25 kN/m3 

respectively unless specifically stated in the project documents otherwise . 

2.1.3 Define Concrete modulus of Elasticitv 

The concrete modulus of elasticity shall be determined based on BS 8110-2 as follows: 
Ee=20+0.2 feu. 28 (1) 

Therefore, for the typical concrete grades used in ATKINS Dubai, the corresponding module of 
elasticity will be as follows: 

Concrete Grade Modulus of Elasticity (GN/m"') 
C4S 29 
CSO 30 
C60 32 
C70 34 

Note: The Poisson's Ratio and Coefficient of thermal expansion shall be taken as 0.2 and 
9.9x10-6 (rC) respectively unless other specific values are approved in special cases. 

2.2 Reinforcement 

The reinforcement properties for gravity design shall be based on BS-811 0 which is taken as 
fy=460 N/mm2. This value is the same for bending and shear reinforcement. 
According to local authorities' requirements, the seismic design of reinforced concrete elements 
shall be based on ACI 318 provisions. As per ACI 318-05 provisions (Section 3.5), the 
reinforcement yield value of fy=420 N/mm2 shall be used. The reinforcement properties that are 
pre-defined in ETABS templates are consistent with ACI design approach and should be revised 
for designs based on BS-811 O. 
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3. Definition and Sizing of Elements 
3. 1 Define Frame Elements 

Frame sections may be defined to the desired dimension or be imported from one of the 
section databases available in ETABS. The user may also import the sections from a user­
defined database with" .pro" extension. Complex, unsymmetrical shapes may be modelled 
using the built-in section designer module. The following general tips may be useful for 
defining frame sections. The reader is urged to refer to ETABS user manual for further details. 

1. It is generally recommended that the material properties are defined first. This assures 
correct material assignment to the member and allows defining similar sections with different 
material property. This feature is particularly useful for tall buildings where grade of concrete 
will change in height. 

2. Rectangular and circular sections may be easily modelled from the available drop-down 
menus, however for irregular shapes the user should use the Section Designer module by 
selecting Define Frame Properties>Add SD Section option. For further information about this 
module, refer to Section Designer Manual published by CSI (1]. 

3. For reinforce concrete rectangular and circular sections, the user may specify one of the 
design types, e.g., Column or Beam. The column design option allows the provided 
reinforcement to be checked or designed, whereas the beam design option is limited to just 
designing the required reinforcement value. 

4. Section property modifiers may be assigned to each section at this stage or later. However it 
should be noted that property modifiers for all frame types may be revised anytime by 
selecting the appropriate member (beam, column or brace) and there is no need to define 
them separately for each section. This will be discussed more in this chapter. 

3.2 Define Shell Elements 

Shell elements are used to define floor, wall and ramp objects as discussed below: 

Define Floor and Ramp Objects 

There are three options to model floor elements in ETABS; Deck, Plank or Slab. A deck 
option may be used to model one way joist and slab, one way slab or metal deck systems. 
Plank and slab options may be used to model one-way or two way slabs with or without one­
way special load distribution. Appropriate shell, membrane or plate property shall be 
assigned to floor members based on their actual behaviour. A membrane element may be 
used to include only in-plane stiffness properties for the member (e.g. walls) where as plate 
type behaviour means that only out-of-plane plate bending stiffness is provided for the 
section. Shell type behaviour considers both in-plane and out-of-plane stiffness properties 
are considered. This type is generally recommended unless the user is confident about the 
realistic behaviour of the member. For membrane and shell type elements, different 
membrane or bending thickness may be defined based on the actual behaviour of the slab 
system as shown in the following example. 

STRUCTURAL Ta'PINC 
(75mm) 

~I 

Pre-cast slab with 75mm topping. 
Bending thickness - 75 mm 
Membrane thickness - 325 mm 
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For thick shell and membrane element, the program is capable of considering the out-of­
plane shear deformation in the analysis. This option is recommended when modelling thick 
floor such as rafts and transfer slabs. 

The section property modifiers may be assigned to each section at this stage or later. 
However it should be noted that property modifiers for all floor objects may be revised 
anytime by selecting the appropriate member (floor, ramp or wall) and there is no need to 
define them separately for each section. This will be discussed more in this chapter. 

Define Wall Objects 

Walls may be defined as shell or membrane elements. However shell behaviour type is 
recommended by ETABS manual [2]. Other modelling features are similar to what has been 
discussed for slabs except for section modifiers which will be discussed more in this chapter. 

3.3 Assign Frame or Shell Section Properties 

Walls and columns may be modelled using either shell or frame sections, however it should 
be noted that using shell elements provide more flexibility and accuracy for modelling 
openings and / or variation in member dimension (width, length) along height. 

When using a frame element (beam) to model a shear wall spandrel, keep in mind that the 
analysis results obtained are dependent on the fixity provided by the shell element that the beam 
connects to. Different sized shell elements provide different fixities and thus, different analysis 
results. 
In general, for models where the spandrels are modelled using frame elements, better analysis 
results are obtained when a coarser shell element mesh is used; that is, when the shell elements 
that the beam connects to are larger. If the shell element mesh is refined, consider extending the 
beam into the wall at least one shell element to model proper fixity. 

If the depth of the shell element approaches the depth of the beam, consider either extending 
the beam into the wall as mentioned above, or modelling the spandrel with shell elements 
instead of a frame element. 

The following criteria may be used for modelling coupling beams: 

Length / Depth < 1.0 or Shell Element 
Length/thick < 5 
Length / Depth> 1.0 or Frame Element 
Length/thick> 5 

3.4 ASSign Frame Section Modifiers 

Use the ASSign menu> Frame/Line> Frame Property Modifiers command to bring up the 
Analysis Property Modification Factors form to assign modification factors for the following frame 
analysis section properties in your model. 
o Cross-section (axial) area 
o Shear Area in 2- direction 
o Shear Area in 3-direction 
o Torsional Constant 
o Moment of Inertia about the 2-axis 
o Moment of Inertia about the 3-axis 
The modification factors are multiplied by the section properties specified for a frame element to 
obtain the final analYSis section properties used for the frame element. Note that these 
modification factors only affect the analysis properties. They do not affect the design properties. 
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The section modifiers for Ultimate limit state analysis for Line Objects are shown in the 
following table based on UBC 97, clause 1910.11. 

Column Beam 
122=133=0.7IQ b2=133=0.35 

A=1.0 Aa A=1.0 Aa 
*When tensile stress IS Induced In particular elements under any of the defined ultimate load 
combinations, the modifier shall be reduced to 0.35 for those elements. 

Ig = Moment of Inertia based on Gross Cross sectional Properties assuming rectangular sections 
for beams. Member design will be based on end-face moments (not centre-point). 

This analysis will be used in arriving at the following results; 

• 
• 
• 

Structural design of all elements 
Pile loads 
Building drift / story drift under seismic loads only 

The Service limit state analysis shall be carried out with the augmented section modifiers as per 
ACI 318 clause 10.11.1 and its commentary, R 10.11.1 that allows multiplying the above section 
modifiers (as per UBC Clause No. 21.3.1) by 1.43. Slabs and beams section modifiers are as 
per ultimate limit state provisions as mentioned above. This analysis will be used to check: 

• Wind Drift (Overall and story drift) 
• Acceleration 
A detailed finite element analysis shall be performed to check the stresses in columns and walls. 
If the stress in any member exceeds the allowable tensile stress value, appropriate section 
modifiers corresponding to the cracked section properties shall be assigned to that member. The 
drift and accelerations shall be checked accordingly. 
To ensure that the stiffness modifiers are assigned to all the elements, it is generally 
recommended to assign the stiffness modifiers after completion of the model and prior to the 
analysis using the "Select by Object Type" option in ETABS. This not only relieves the laborious 
task of defining the stiffness modifiers separately for each frame section, but also provides a 
quick, yet reliable way to change these modifiers in no time. 

3.5 Assign Shell Section Modifiers 

Use the Assign menu> Shell/Area> Shell Stiffness Modifiers command to bring up the Analysis 
Stiffness Modification Factors form. Here you can specify Stiffness Modifiers for the following 
shell analysis section stiffness in your model. 
D Membrane f11 Modifier 
D Membrane f22 Modifier 
D Membrane f12 Modifier 
D Bending m11 Modifier 
D Bending m22 Modifier 
D bending m12 Modifier 

The stiffness for each of the items calculated based on the section properties specified for a 
shell element are multiplied by the specified modifiers to obtain the final stiffness used for the 
shell element in the analysis. Note that these modification factors only affect the analysis 
properties. They do not affect any design properties. 

The f11, f22 and f12 modifiers are essentially equivalent to modification factors on the thickness 
(t) of the shell element. The m11, m22 and m12 modifiers are essentially equivalent to 
modification factors on the (t) 3 of the shell element. 

The section modifiers for Ultimate limit state analysis for Area Objects are shown in the 
following table based on UBC 97, clause 1910.11. 
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Wall{lJ,l:l) Coupling Beams Slab 
(Shell)(3) 

m11= m22=0.7 (Uncracked) f11=f12= f22=m22=0.35 m11= m12=m22=0.25 
m11= m22=0.35 (Cracked) 

(1)- The correct parameters that need to be modified to reflect cracked section properties for 
walls are f11 & f22' however due to the inevitable axial shortening, JAFZA requires that m­
parameters be revised. Refer to the discussion below for further clarification. 

(2)-lt should be noted that revising stiffness modifiers to cater for cracked sections in shell 
elements in trivial. The gross section area based on UBC 97 (Clause 1910.11) and ACI 
318(Section 10.11) provisions should not be changed. This may be easily accounted for 
frame elements by just revising the section modifier for moment of inertia. However, the 
axial and bending stiffness for shell elements can not be de-coupled, i.e., changing the 
bending stiffness will inevitably affect the axial stiffness. This may cause displacement 
incompatibility with adjacent frame column which in turn may require revising the axial 
stiffness for vertical frame elements, as opposed to code explicit provisions. 

(3)-Lower stiffness modifier values may be assigned for coupling beams based on the actual 
state of cracking in the element from the analysis results. 

3.6 Assign Pier / Spandrel Label 

The pier / spandrel labelling is a convenient way to get the design forces for walls and 
coupling beams especially when they are modelled as shell elements. Special care shall be 
taken when defining these labels to ensure realistic values. The reader is urged to refer to 
CSI's ETABS Manual and Shear Wall Design Manual for further details. 

A wall pier can consist of a combination of both area objects (shell elements) and line objects 
(frame elements). If you want to get output forces reported for wall piers, or if you want to design 
wall piers, you must first define them. Define a wall pier by selecting all of the line and/or area 
objects that make up the pier and assigning them the same pier label. If a wall pier is made up of 
both line and area objects, assign the pier label to the line and area objects separately. 

A wall spandrel can consist of a combination of both area objects (shell elements) and line 
objects (frame elements). If you want to get output forces reported for wall spandrels, or if you 
want to design wall spandrels, you must first define them. Define a wall spandrel by selecting all 
of the line and/or area objects that make up the spandrel and assigning them the same spandrel 
label. If a wall spandrel is made up of both line and area objects, assign the spandrel label to the 
line and area objects separately. 

3.7 Assign Area Mesh Option 

Selected areas can be meshed using the Edit>Mesh Areas command toolbar button. Several 
options are available in the Mesh Selected Areas form: 
r Auto Mesh Area (Horiz): This option meshes the selected area into smaller areas. The 
smaller areas are three-sided or four-sided and must have beams on all sides. 

n Cookie Cut at Selected Line Object (Horiz): This option meshes the selected area at the 
selected lines. Select one or multiple lines. If the selected line passes through more than one 
area, all of the areas will be meshed. Note that this and the Auto Mesh Area option only work in 
plan view. 

n Cookie Cut at Selected Point at [Specified] Angle: Use this option to mesh areas at a 
specified point and angle. The angle will be measured in the counter clockwise direction for the x 
and y-axis. If the point lies in the overlapping region of two areas, both of the areas will be 
meshed at the given angle. 
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o Mesh Quadsrrriangies into [Specified Number] by [Specified Number] Areas: This option 
meshes the selected area in the number of areas specified by the user. For example, specifying 
a meshing of 2 by 8 means that the selected area will be meshed into 2 areas along the x-axis 
and 8 areas along the y-axis. The size of the meshed areas will be uniform along a given 
direction. Only quads and triangles can be meshed using this option. 

o Mesh Quadsrrriangies at Intersections with Visible Grid Lines: This option meshes each 
selected area at any location where it intersects a visible grid line, regardless of the coordinate 
system associated with the grid line. 

o Selected Point Objects on Edges: Selecting this option will mesh the area (horizontally and 
vertically) using the selected point at the edge as reference. One more points can be selected 
for this type of meshing. 

o Interactions with Selected Line Objects: The areas selected are meshed with the line 
intersecting the area. More than one line can be selected to mesh a desired area. 

Note the following about Meshing Area Objects: 

OThe property assignments to meshed area objects are the same as the original area object. 

OLoad and mass assignments on the original area object are appropriately broken up onto the 
meshed area objects . 

DWhen this menu item is dicked, all edges of the currently selected area will be split at their 
mid-points. If clicked again for the same selected area, they will be divided in half again, and so 
on. 

The program does not offer any automatic meshing for walls, however, for slab elements, the 
automatic meshing option may be done as shown below. 
Area Object Auto Mesh Options .. ; 

Floor Meshing Options -------

r Default (Auto Mesh at Beams and Walls if Membrane· No Auto Mesh if Shell 01 Plate) 

r For Defining Rigid Diaphragm and Mass Only (No Stiffness - No Vertical Load Transfer) 

r NoAuto Meshing (Use Object as Structural Element) 

r. Auto Mesh Object into Structural Elements 

P" Mesh at Beams and Other Meshing Lines 

P" Mesh at Wall and Ramp Edges 

r Mesh at Visible Grids 

P" lFui"iflei""S"uhdi"vT(j"e"A'u"t~""Mesh"w,th"M'a";C,mum"tiement"STze"o"f, r; .............................................................................................................................................. : 

r 

Ramp and Wall Meshing Options 

r. No Subdivision of Object 

r Subdivide Object into I vertical and I horizontal 

l 

l r Subdivide Object into Elements with Maximum S_iz_e_o_f _________ -' 

OK 
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Note-1: In general, slab elements may be drawn manually, but this is time consuming and may 
lead to unrealistic results if local axes of slabs are different or unsuitable mesh sizes are used. 
Complex floor systems supporting many walls and columns (e.g. Raft) may be meshed in other 
finite element programs such as Robot and then imported into ETABS. 

Note-2: In general triangular plate-bending element, with shearing deformations, produces 
excellent results. However, the triangular membrane element with drilling rotations tends to lock, 
and great care must be practiced in its application. Because any geometry can be modelled 
using quadrilateral elements, the use of the triangular element presented can always be 
avoided . 

3.8 Assign Auto-Line Constraint 

Auto-line constraint is a technique in ET ABS that is very useful in reducing the hassle of fine­
tuning meshing of adjacent objects. If the meshes on common edges of adjacent area objects do 
not match up, automated line constraints are generated along those edges. These Line 
Constraints enforce displacement compatibility between the mismatched meshes of adjacent 
objects and eliminate the need for mesh transition elements. 
The following figures show the difference in results when applying auto-line constraint to a 
simple model where slab and wall meshing does not match. 
The auto-line constraint is the default option in ETABS and needs to be removed manually if 
required . 

Case1 : Without Auto-line constraint 
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4. Supports 
4. 1 General Support Conditions 

• In reinforced concrete structures on single or mat foundation, the support conditions 
are taken as fixed (all rotational and translational degrees of freedom are locked). 

• Where raft (or single) piles are modelled in ETABS, however, the support conditions 
may be taken as free (no rotational and translation D.O.F is locked) or pinned. The piles 
for this case need to be modelled with appropriate springs. Some guidelines for this 
purpose is explained in the following section . 

4.2 Modelling Piles as Supports 
• Piles are modelled in ETABS as springs where the spring stiffness-corresponding to 

the pile vertical and horizontal stiffness- is used by ET ABS for analysis purpose. The 
stiffness of these springs may be calculated based on the maximum allowable axial 
force and settlement of the pile. 

• 

• 

The maximum allowable axial stress on a pile may be limited to 0.25fcu. On the other 
hand, the maximum allowable settlement for a pile is generally given by the 
geotechnical expert. In lieu of these data (and as directed by JAFZA), this value may 
be taken as 1 % of pile diameter (in mm). Therefore the vertical spring stiffness may 
be expressed as: 

k = O.25 fclI·A pile = O.25fclI·ml2 ;;; 20d 
v 8 all 4xO.Old 

The horizontal pile stiffness is taken as 10% of the vertical value . 
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5. Loading 
5. 1 Dead Loads 

Since ETABS can calculate the self-weight of different elements defined and apply their 
load in static analysis, it is important to define dead loads appropriately. The self-weight 
and imposed dead loads shall be defined separately as explained below: 

5.1.1 Assign Self Weight 

The self-weight multiplier controls what portion of the self-weight is induded in a load 
case. A self-weight multiplier of 1 means that the full self-weight of the structure is 
included in that load case. 

5. 1.2 Define Imposed Dead Load 

This type of loading shall be used to define any other type of permanent load acting on the 
structure, exduding the self-weight of structural elements that are modelled in ETABS. 
Load associated with floor finishes, raised flooring, ceiling, services and permanent 
partitions are examples of this type of loading. 

Loads Click To: 

Load Type 

DEtan n~An ........... 
( SELFW 1\ DEAD' 

I-Jill ~ 

......... -" 

Self Weight 
Multiplier 

~ O 

" """ .~ . m . [!il · 

-
-.j 

Auto 
Lateral Load 

v 

Add New Load 

Modify Load 

Modify Lateral Load ... 

Delete Load 

OK 

Cancel 

5.2 Live Loads 
5.2. 1 General 

Live loads shall be defined as reducible or irreducible based on their magnitudes. As per 
ASCE7 provisions (which is also adopted in UBC), lie loads in excess of 4.79 kN/m2 shall 
be taken as irreducible. 
The live load values shall be assigned in accordance with the values adopted in Design 
Statement and the specific code requirements. 

5.2.2 Reduction of Live Loads 

A live load that is specified as reducible is reduced automatically by the program for use 
in the design postprocessors (and hence doesn't have any effect in the analysis results). 
The live load reduction parameters are specified using the Options menu> Preferences 
> Live Load Reduction command. 
It is important to ensure that the self-weight multiplier is set to zero (0) for all load cases 
except self-weight. 
It should also be noted that Load Combinations do not include live load reduction unless 
required specifically. Therefore, this shall be considered when using other supplementary 
design software (e.g. PROKON). 
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5.3 Mechanical Loads 

Mechanical loads are irreducible live loads that are generally used to represent the effect 
of areas with special equipment or facility (substations, plant rooms, etc). This definition 
will help to differentiate between the live loads that are NOT permitted by the code to be 
reduced. For example, as stated earlier in this chapter, ASCE7 and USC 97 define any 
live load exceeding 4.79 kN/m2 as irreducible live load. Therefore these loads shall be 
defined as a MECH load to ensure that they are not reduced for member design. 

Loads 

Load Type 

IMECH I LIVE 
i====:==::====', 

5.4 Wind Loads 

Self Weight 
Multiplier 

Auto 
Lateral Load 

Click To: 

Add New Load 

Modify Load 

I Modify Lateral Load. .. , 

Delete Load 

OK 

Cancel 

In general, there are two ways to define lateral loads (Wind, earthquake, etc) in ETASS: 
Use one of the built-in options that will automatically calculate the lateral loads as per 
available design codes or specify the lateral loads manually. The latter is used to apply the 
wind loads determined from the Wind Tunnel Test. 

5.4. 1 Codified Methods 

Codified wind loads that are approved by JAFZA are limited to ASCE 7 and AS/NZS 
1170.2. However, DM I Tecom currently also accept design wind loads as per BS 6399, 
Part-2. The procedures to define codified wind loads as per ASCE 7 and BS 6399 Part-2 
are described briefly below: 

5.4.1.0 Define Wind Load Parameters as per ASCE 7 

The ASCE 7-02 wind load parameters shall be determined from respective Code sections 
and input in the ASCE 7-02 Wind Loading Table of ETABS. Then ETABS will automatically 
calculate the wind loads acting on each story level and use it in the static analysis 
processor. A sample form of ASCE 7-02 wind parameters is shown below followed by a 
brief description on key items. 
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Exposure and Pressure Coefficients 

@ Exposure from Extents of Rigid Diaphragms 

o Exposure from Frame and Area Objects 

Wind Coefficients 

Wind Speed (mph) 

Exposure Type 

lQ1)ortance Factor 

Wind Exposure Parameters 

Wind Direction Angle 

Windward Coefl. Cp 

Leeward Coefl. Cp 

r-I ------,1 
~. . 

~I =====:1 
~.8 . 

~I T opographical Fact~, Kzt 

Gust Factor 

Directionality Factor, Kd 

Solid I Gross Area Ratio 

Case (ASCE 7-02 Fig. 6-9) 

e2 (ASeE 7-02 Fig. 6-9) 

e1 (ASCE 7-02 Fig. 6-9) 

tv! odify/Show E xposLle Widths ... 

Exposure Height 

Top Story I STORY4 III 
Bottom Story I BASE I 

OK 

D Include Parapet Cancel 

Parapet Height I 
1 

Design Wind Load Case: Choose Create All Cases, so that all design wind load 
cases are determined as per Fig.6-9 of ASCE 7-02, taken into account the 
torsional moment effects . 
Eccentricity: Determine the eccentricity values for the structure as per Clause 
6.5.12.3 and Fig.6-9 of ASCE 7-02. For rigid structures, defined as structures 
with natural frequency of greater than 1 Hz (T1<1 sec.), the eccentricity shall be 
taken as equal to 15% of the building dimension in the perpendicular direction. 
Otherwise, use Equation (6-21) in Clause 6.5.12.3 of ASCE 7-02 to calculate this 
parameter. 
Wind Speed: In lieu of reliable wind tunnel studies, the basic wind velocity shall 
be taken as 45 m/sec (101 mph) as per local authority requirements. Note that 
the basic wind speed shall be input as mph in ETABS. 
Other Parameters: Other parameters shall be determined as per provisions of 
ASCE 7. The exposure type is generally taken as Exposure C for Dubai, but 
should be verified with the wind specialist accordingly. An approved design 
spreadsheet may be used to reliably calculate all the parameters of ASCE 7-02 
wind load data. 

5.4.1.1 Define Wind Load Parameters as per as 6399-Part-2 

The BS 6399-95, Part-2, wind load parameters shall be determined from respective Code 
sections and input in the BS 6399-95 Wind Loading Table of ETABS. ETABS will 
automatically calculate the wind loads acting on each story level and use it in the static 
analysis processor. A sample form of BS 6399-95 wind parameters is shown below 
followed by a brief description on each item. 

Page 3 ofll 



WS Atkins & Partners Overseas 

Exposure and Pressure Coefficients 

@ Exposure from ElCtents of Rigid Diaphragms 

o Exposure from Area Objects 

Wind Exposure Parameters 
J 

Wind Direction Angle 10. 
~======: 

Front Coef!. Cp 10.8 
~======: 

Rear Coef!. Cp 1'-0_.3 ___ -' 

M odify/S how Exposure Widths ... 

Exposure Height 

Top Story 

Bottom 5 tory 

o Include Parapet 

Parapet Height 

I STORY4 

I BASE 

iii 
"I 

Wind Coefficients 

Effec Speed. Ve 1m/sec) 

Size Effect Factor. Ca 

Dyn Augment Factor. Cr 

OK 

Cancel 

Effective Speed: The effective wind speed shall be determined as per Clause 
2.2.3 of BS 6399-2. The Site Wind Speed (Vs) required for this calculation shall 
be taken as 26 m/sec for Dubai in lieu of reliable wind tunnel stUdies. 
Size Effect Factor: The size effect factor shall be determined from Clause 
2.1.3.4 of BS 6399-2. 
Dynamic Augmentation Factor: The dynamic augmentation factor shall be 
determined from Clause 1.6.1 and Fig.3 of BS 6399-2. 

Note 1- An approved design spreadsheet may be used to reliably calculate all the 
parameters of BS 6399 wind load data. 

Note 2- As per BS 6399-97, Part-2 provisions of Section 2.1.3.7, accidental torsional 
effects on the buildings may be accounted for by displacing the wind loads on each 
face horizontally by 10% of the face width from the centre of the face. This can not be 
directly taken into account in ETABS and needs to be applied manually. For this 
purpose, wind loads may be determined as per note-1 and then applied to the 
building as a User Defined Load in Auto Lateral Load drop-down menu. Refer to 
Section 7.4.2 for more details. 
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5.4.2. Extracting Wind Loads from Wind Tunnel Test Results 

The results of a reliable wind tunnel test may be used in lieu of the codified values for 
wind analysis in ETABS. These loads are generally calculated by recognized wind 
tunnel testing laboratories based on the dynamic properties of the structure as 
modelled during the preliminary or concept design stages. Wind loads are reported 
as separate load cases that should be combined through the set of load 
combinations as reflected in the wind tunnel report. It is important to note that these 
loads shall be applied to the analytical model at the same reference points that were 
initially defined for the wind tunnel consultant. Moreover since the Wind consultants 
generally carry out their calculations at the center of the diaphragm of each floor, it is 
recommended that these points are taken in locations where are as close to the 
center of mass of diaphragm as possible . 
Wind loads obtained from wind tunnel studies may be defined in ETABS as a User 
Defined Lateral Load. A separate wind load case shall be defined representing the 
load case as per wind tunnel report. The load values may directly be copied from a 
spreadsheet. Various load combinations shall also be defined accordingly. The 
following figures show an example of defining user defined wind load cases. 

- 1 t ,I • 

SeI\IIed1t Aao 
MuitPer Lateral Load Add N IIW Load Load Type 

WIND \IIIND -" a I User Defined &II DEAD DEAD 1 
Mocify Load 

LIVE LIVE 0 , 
11'.,lm if:) 131101' ~fljIOI. I !I.. 

[ Mocify Lllterlll Load. .. I 

/ D Delete Loed 

OK 

CMeet I 

~------------~~==~~------~ 

USet W"ind Loads on O~agm. 

StOI)J Oiaph,a!JTl FX FY MZ X.(J,d Y.(J,d "'1 
TOP 01 353.1 O. O. 18.1392 ·7.429E~ I 

55TH (ROOF) 01 219.9 O. O. 181392 ·7.429E~ 

54T H [BAR) 01 237.6 O. O. 19.1392 ·7.429E~ 
53TH REST 01 246.2 O. O. 18.1392 ·7.429E~ 

52TH SERVICE 01 241 .7 O. O. 18.1392 ·7.429E.(J' 
51TH 01 185.8 O. O. 18.1392 ·7.429E~ 
50TH 01 181 .5 O. O. 18.1392 ·7.429E~ 

49TH 01 177.3 O. O. 18.1392 ·7.429E-O' 
48TH 01 174.9 O. O. 18.1392 ·7.429E·O:: 
47TH 01 170.9 O. O. 18.1392 ·7.429E·O' 
46TH 01 167. O. O. 18.1392 ·7.429E~ 

45TH 01 163.2 O. O. 18.1392 ·7.429E~ 

44TH 01 159.5 O. O. 19.1392 ·7.429E~ 
43TH 01 157.4 O. O. 18.1392 ·7.429E~ 

42TH 01 153.9 O. O. 18.1392 ·7.429E~ 

41TH 01 150.5 O. O. 18.1392 ·7.429E~ 

40TH 01 147.3 O. O. 18.1392 ·7.429E~ 

39TH 01 145.2 O. O. 18.1392 ·7.429E~ 

38TH 01 142.2 O. O. 18.1392 ·7.429E~ 

37TH 01 1782 O. O. 18.1392 .~.~~;!~ 
~TI It,..,..n, ",...,.., n< i n .. ,.. n n 1 n1.,,,..., 

Cancel ] 
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5.5 Earthquake Loads 

The earthquake effects shall be determined based on the provisions of USC 97, Chapter 16. The 
Response Spectrum Method shall be used for all buildings with more than 12 storeys in height as 
per JAFZA requirements. However, the results of response spectrum analysis may be scaled to 
the Equivalent Static Force Method as per Clause 1631.5.4 of USC 97. Therefore, the Equivalent 
Static Force Method shall be initially used. The following SUbsections review the basic parameters 
required in ETASS. 

5.5. 1 Equivalent Static Force Method 
5.5.1.1 Define Earthquake Parameters as per uac 97 

Loads 

load Type 
Self Weight 

Multiplier 

EQX QUAKE 
DEAD DEAD 
LIVE LIVE 

':IIn: PUma 

Direction and Eccentricity 

O x Oir 

£iI 0 

1 
0 

O Y Oir 

O Y Oir + EccenX 

O Y Dir· EccenX ~
• Dir+EccenY 

Oir· EccenY 

1 cc. Ratio (All Diaph.) r--~:;:;;;;2~=~ 
Override Diaph. E=e 

Time Pellod 

o Method A 

® Program Calc 

o User Defined 

Story Range 

Top Story 

BoUom Story 

Factors Il 
Overstrength Factor. R~"":~~7'----..J I 

OK 

Auto 
Lateral Load 

UBC97 ~ . 
~1I!1 Rr ," 

BOCA 96 
LJIoJRrrq" 1..:1 
IBC ~g~g .!...! 
NEHRP97 

~ Chinese 2002 

D 

Seismic Coefficients 

® Per Code 

Soil Profile T~ 

Seismic Zont..::...J 

User Defined Ca 

User Defined Cv 

Near Source Factor 

Click To 

Add New Load 

Modify Load 

Modify loterollood ... 

Delete Lood 

OK 

Concel 

• Per Code User Defined 

1 
Seismic SOUlce Type [--

Dist to Source (km) 

User Defined Na 

User Defined Nv 

Other Factors 

Importance Factor I 

Cancel 
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The parameters that need to be defined in this form are briefly described below: 

[!Jo 

~o 

Direction and Eccentricity: Use the % Eccentricity edit box to specify a value for 
eccentricity. Five percent is the default and is entered as 0.05. The eccentricity options 
have meaning only when diaphragms have been assigned to joint/point or shell/area 
objects. The program ignores eccentricities where diaphragms are not present. 

Note that since the Equivalent Static analysis is often used for scaling the Response 
Spectrum parameters, the eccentricities need only be calculated for both directions with 
only one direction of eccentricity (Le. X+ey and Y+ex) 

Time Period: If using the Program Calculated option, the Ct coefficient shall be input in 
Imperial units. This value shall be taken as 0.02 for RC Shear Walls and 0.03 for RC 
Moment Resisting Frames. 

Story Range: By default the bottom story is the base of the building and the top story is 
the uppermost level of the building. 

o In most instances, specify the top story as the upper-most level in the building, 
typically the roof. However, in some cases, a lower level may be chosen. For 
example if a penthouse is included in the model, it may be best to calculate the 
automatic lateral load based on the roof level, excluding the penthouse roof level, as 
the top story, and then add in additional user-defined load to the load case to account 
for the penthouse. 

o The bottom level would typically be the base level. However, if, for example, a 
building has several below-grade levels, and the seismic loads are assumed to be 
transferred to the ground at ground level, it may be best to specify the bottom story to 
be above the base of the building. 

Note: No seismic loads are calculated for the bottom story. They are calculated for the 
first story above the bottom story and for all stories up to and including the top story. 

Overstrength Factor: Determine the strength reduction factor as per UBC 97, Table16-
N based on the structural system used. For Bearing Shear wall system use a value of 
R=4.S and for Building frame system with shear walls use R=S.S. Refer to Section 1629.6 
of UBC 97 for definition of different structural systems. In general, if the majority of gravity 
loads are taken by the shear walls, take R=4.S. 

Note: For structures where more than one system is used throughout all or part of the 
structure, the provisions of UBC 97 for Dual systems shall be met. Alternatively, one 
system may be assumed to take all the lateral loads and the other is taken as a building 
frame system. For such cases, the lateral forces need to be scaled up to ensure that all 
the lateral loads are carried by respective system. 

Seismic Coefficient: For Dubai, the seismic zone 2A (corresponding to z=0.1S) is taken 
unless otherwise stated by a site-specific seismic hazard study approved by local 
authorities. The Soil profile type shall be taken from the site soil investigation 
report. [Note: Most geotechnical consultants recommend soil profile type Sc for Dubai] 

Page 7 of 11 



WS Atkins & Partners Overseas 

5.5.2 Response Spectrum Method 

5.5.2.1 Define Response Spectrum Functions as per uac 97 

Add UBC 97 Spectrum from the drop-down list to display the Response Spectrum 
uac 97 Function Definition form. 

Response S pectr a 

Parameters 

Seismic Coefficient Ca 

Seismic Coefficient Cv 

Function Name 

I [ Convert to User Defined I 
I Function Graph 

Display Graph 

OK 

J I· 

Click to: 

Add Spectrum from File ... 

Dehne Function 

Period 

lUBe 

Acceleration 

( 8.5764 . 0.0292) 

Cancel 
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r,-, . Parameters: Specify parameters for Seismic Coefficient Ca and Seismic 
~oefficient Cv based on seismic zone and soil profile type (See Tables 16-0 and 16-R in 

the 1997 UBC). For seismic zone 2A and soil profile type Sc (Typical of Dubai), take Ca 
=0.18 and Cv =0.25, respectively. 

5.5.2.2 Define Response Spectrum Cases 

The following topics describe key parameters for the response spectrum case data: 

Spect,,, Cick. to: 

I OK I 
[ Cancel I 

[!] 0 Structural and Function Damping 

This item specifies modal damping that is present 
for all modes in the response spectrum analysis. 
Also, ETABS assumes that the response spectrum 
functions specified for the response spectrum case 
are all specified for this particular damping ratio. 

As per local authorities provisions, a damping ratio 
of 5% is assumed for response spectrum analysis. 

D o Modal Combination 

Select QQQ method since it provides good 
estimates of the results for most practical cases. 

D 0 Directional Combination 

Select ~ method since it provides good 
estimates of the results for most practical cases 
and is also consistent with UBC-97 provision for 
orthogonality effects. 
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Spedlu. Case Hallie I SPED< 

Structural and Function Damping 
~~-...., 

Dcnping [!] .... 'O._ffi,.,..._-' 

Modal Combination 

o SRSS 0 ABS 0 GMC 

'--_--'I f2 1'--_----'1 

Orthogonal SF 

o Mociied SRSS {ChileseJ 

Input Response S peetr a 

FU"dion 

U2 

S caIe Factor 

uz '---~I 1 I 
Elicitation <I'I.je ([) lZJ 

~l 
E eeentllcity 

Ece. Ratio [All Oiaph.J 

Override Diaph. Eccen. I Override ... 

OK I CaM I 
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o 0 Input Response Spectra 

Specify the defined USC-97 response spectrum function for each of the three local 
coordinate system directions as separate response spectrum case. 

~o Scale Factor 

The scale factor has units of Length/seconds2 and that its value will change as you 
change the units in your model . Essentially ETASS assumes the response spectrum 
functions are unitless (normalized) and that the scale factor converts them into the 
appropriate units (i.e. use a scale factor of 9.81 to convert USC 97 spectrum into 
acceleration (m/sec2» 

If you are scaling your response spectrum to match some static analysis results (e.g., 
static base shear), you may want to include that in the scale factor specified for the 
response spectrum function in the input response spectra area. In that case you 
would input a scale factor equal to the product of the scale factor to convert the 
spectrum to the appropriate units and the scale factor to scale the response spectrum 
base shear to the appropriate level. 

It is recommended that a uniform approach is adopted to provide a consistent 
method of incorporating scale factors. The method used in Atkins office in Dubai is to 
use the scale factor of g/R in this area to convert the spectrum into m/sec2 units. 
Then based on the results of first-run, the appropriate scale factor between the 
equivalent static method and the response spectrum method may be calculated and 
used in an appropriate Load Combination. The advantage of this method is that it 
doesn't require any additional analysis, since Load Combinations can be modified 
anytime, even after an analysis. Appendix (---) includes an example that helps to 
illustrate this issue. 

o 0 Excitation Angle 

The excitation angle is an angle measured from the positive global X-axis to the 
response spectrum case positive local 1-axis. A positive angle appears counter 
clockwise as you look down on the model. 

It should be noted that when SRSS method is used for directional combination of 
responses, the response would be independent of the excitation angle. However, 
using an appropriate angle -along the principal axes of the building- may be useful 
(and sometimes required) when uni-directional response parameters are of interest. 
The reader may refer to Wilson book [Ref. 1] for further details. 

o 0 Eccentricity Ratio 

The eccentricity ratio is initially taken as the accidental eccentricity (5%), but may 
need to be adjusted if Torsional Irregularity exists in the model based on provisions of 
uac 97, Clause 1630.7 and definitions of uac 97, Table 16-M. 

To revise the eccentricity ratio, a preliminary analysis shall be carried out assuming 
the minimum code mandatory ratio of 5%. The displacement values of four points at 
the corner edge of the building for each story is then determined. The amplification 
factor for accidental torsional response, Ax. i for each floor is calculated based on the 
provisions of USC 97, Clause 1630.7 from the average and maximum displacement 
results as follows: 
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The maximum value of Ax. i is used to amplify the eccentricity ratio. It should be noted 
that this amplification need only be applied once and need not be revised iteratively. 
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6. Load Combinations 
6. 1. Define Load Combinations for Serviceability State 

SLC1: 1.0 DL + 0.5 LL+ 1.0 MECH 

SLCS01: 
SLCS02: 

SLCS03: 
SLCS04: 

SLCW1: 
SLCW2: 

0.90 DL + 0.714 SRSS 

0.90 DL - 0.714 SRSS 
1.0 DL + 0.375 LL + MECH + 0.536 SRSS 

1.0 DL + 0.375 LL + MECH - 0.536 SRSS 
1.0DL +1 .0 Wind(x & y)(1) 

1.0DL-1 .0 Wind(x & y)(1) 

6.2. Define Load Combinations for Ultimate State 

ULC1: 104 DL + 1.6 MECH + 1.6 LL 

ULCS01 1.29 DL + MECH + 0.5 LL + 1.0 SRSS 
ULCS02 1.29 DL + MECH + 0.5 LL - 1.0 SRSS 
ULCS03 1.11 DL + MECH + 0.5 LL - 1.0 SRSS 
ULCS04 1.11 DL + MECH + 0.5 LL + 1.0 SRSS 

ULCS05 0.B1 DL + 1.0 SRSS 
ULCS06 0.B1 DL - 1.0 SRSS 
ULCS07 0.99 DL + 1.0 SRSS 
ULCSOB 0.99 DL - 1.0 SRSS 
ULCUP01 104 DL + 1.6 MECH + 1.6 LL + 1.2 UPLIFT 
ULCUP02 1.0 DL + 1.2 UPLIFT 
ULCUP03 104 DL + 1.2 UPLIFT + 104 WIND(x & y)(1) 
ULCUP04 104 DL + 1.2 UPLIFT - 104 WIND(x & y)(1) 
ULCUP05 1.0 DL + 1.2 UPLIFT + 104 WIND(x & y) (1 ) 
ULCUP06 1.0 DL + 1.2 UPLIFT - 104 WIND(x & y) (1) 
ULCUP07 1.4 DL + 1.2 UPLIFT 

0.5 .c;,. . .1 
[1. 2+0. 5xO. 18x1=1.29] 

[1 .2-0.5xO.1Bx1=0.B1] 

ULCUPOB 1.2DL + 1.2 MECH + 1.2 LL + 1.2 UPLIFT + 1.2 WIND(x & y) (1) 
ULCUP09 1.2DL + 1.2 MECH + 1.2 LL + 1.2 UPLIFT - 1.2 WIND(x & y) (1) 

ULCUP10 1.2DL + 1.2 MECH + 1.2 LL + 1.2 UPLIFT 
ULCW01 1.2 DL + 1.2 MECH + 1.2 LL + 1.2 WIND(x & y) (1) 
ULCW02 1.2 DL + 1.2 MECH + 1.2 LL - 1.2 WIND(x & y) (1) 
ULCW03 1.0 DL + 1.4 WIND(x & y) (1) 
ULCW04 1.0 DL - 104 WIND(x & y) (1) 
ULCW05 1.4 DL + 104 WIND(x & y) (1) 
ULCW06 104 DL - 104 WIND(x & y) (1) 

6.3. Define Load Combinations for Pile Design 

SLC1: 1.0 DL + 0.5 LL + 1.0 MECH 
0.90 DL + 0.714 SRSS 

0.90 DL - 0.714 SRSS 
[1/1.4=0.714 SRSS] SLCS01 

SLCS02 
SLCS03 
SLCS04 

1.0 DL + 0.375 LL + MECH + 0.536 SRSS [O.75x(1/1.4)=0.536] 

, SLCW05 

SLCW06 

1.0 DL + 0.375 LL + MECH - 0.536 SRSS 
O.B DL + OALL + O.B MECH +O.B WIND(x & y) (1) 
O.B DL + OALL + O.B MECH -O.B WIND(x & y) (1) 

(1)- When wind loads are derived from wind tunnel test results, WIND(x & Y) may be taken 
conservatively as the Envelope of all possible wind load combinations as prescribed by Wind 
Tunnel specialist. 
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7. Analysis Option 
7. 1 Dynamic Analysis Parameters 

• Number of Modes: Specify the number of Eigen or Ritz modes that you want ETABS 
to capture. Generally use a relatively low number of modes for initial analysis to save 
time. A more refined estimate of the proper number of modes may be determined by 
interpretation of modal participation factor ratio after the initial run. The total number of 
modes considered in the analysis shall include at least 90% of the participating mass of 
the structure for each principal horizontal direction. 

• Type of Analysis options. Choose eigenvector or ritz-vector analysis in this area. 
Input in the balance of the form depends on which option is chosen. 

Note: If you are running response spectrum or time history analysis, use ritz-vectors. 

Note: For response spectrum analysis, select the ACCELERATION along X and Y 
directions as the Starting Load Vectors. 

7.2 P-Delta Analysis Options 
General: 

• It is recommended [Ref. 1 & 2] to use the iterative method in all cases except 
those where no gravity load is specified in the model. Iteration Controls: 
Generally an iteration value of 3 or 4 will be adequate. Note that the 
maximum number of iterations specified is the maximum number of additional 
analyses after the first analysis is run. 

• P-Delta Load Combination: Specify the single load combination to be used 
for the initial P-Delta analysis of the structure. The following load cases shall 
be used based on the adopted Design Code: 

Code P-Delta Load Combination 
BS 8110 1.00+1 .0 Mech+0.5 LL 

UBC-97, ACI318 1.2D+1 .2Mech+0.5 LL 

7.2. 1 Provisions for Local Authorities Other Than JAFZA 
7.2.2 Provisions for JAFZA 

JAFZA requires that P-Delta analysis using Iterative method shall be 
carried out for all buildings exceeding 12 storeys in height .However, it should 
be noted that according to UBC-97 , Clause 1630.1 .3, P-Delta analysis is not 
required when the ratio of the secondary moment to primary moment does 
not exceed 10. Due to the relative ease of P-Delta analysis in ETABS, it is 
recommended to initialize the design using this method and use the code 
exception, whenever applicable, for cases when P-Delta effect results in 
excessive responses that need to be avoided. 
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8.0 Post Analvsis Checks 

After a model is analyzed by ETASS it is very important to check the whether the basic 
characteristics of the model matches with the expected behaviour or not. In the following sections 
some key features will be addressed. 

8.1 Analvsis .LOG and Results 

The analysis log file may be reviewed either from the File menu> Last Analysis Run Log ... 
command or it can be opened by a text editor from the directory containing the model. There are 
two important items that should be checked: 

8. 1. 1 Warnings 

A warning is produced during solution of equilibrium equation in ET ASS when there is an error in 
calculation of finite element stiffness matrices, boundary condition or the applied loading. If you 
come across warning messages for solution along any degrees of freedom, you will need to 
locate the point(s) and check for any potential error .This may be caused by adjacent points 
forming a discontinuous mesh, a free-free end support etc. These warnings may be removed by 
reshaping the objects, defining appropriate boundary conditions I supports or any other suitable 
action that ensures a sound analytical model. 

8. 1. 2 Global Force Balance 

Global force balance relative errors are one of the key measures that can be used to ensure the 
accuracy in analysis solution. These errors are calculated based on the relative difference in 
applied external loads and the base reactions for each load case. 
The global force balance relative errors should be very small -in order of 10-10 -and less. It should 
be noted that this is a necessary but not sufficient condition to ensure a sound modelling and 
analysis. 

8.2 Deformed Shape and Model Animations 

It is recommended to thoroughly investigate the deformed shape of the structure under static 
loads. This may be done by animating the structure for the required load case. The animated 
deformation shall match with the anticipated behaviour of the building. Appropriate scale factors 
may be used to examine the response. 

8.3 Modal Characteristic 

Mode shapes of the building give a good insight into the dynamic characteristics of the structure. 
The first few modes of vibration are of particular concern since generally they indude most of the 
dynamic response; however this shall be verified from the modal participation factor. For example 
if a torsional mode shows a high participation factor, the designed may look for revised structural 
scheme that may help minimize torsional effects. 
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9. Reinforced Concrete Design Module 

9.1 
9.1.1 

Shear Wall Design Module (as per as 8110 - 97) 
Overview 

In the design of shear walls, the program calculates and reports the required areas of steel for 
flexure and shear based upon user defined load combinations. The reinforcement requirements 
are calculated at a user-defined wall labelling (wall pier / spandrel labelling). 

The program also performs the following design, check, or analysis procedures in accordance 
with BS 8110-97 requirements: 

• Design and check of concrete wall piers for flexural and axial loads 

• Design of concrete wall piers for shear 

• Design of concrete shear wall spandrels for flexure 

• Design of concrete wall spandrels for shear 

9.1.2 T ermin%gy 

Analysis Section 

These are the objects (area/line) defined in the model to make up the pier or spandrel section. 

Wall pier analysis section is the assemblage of wall & column sections & Wall spandrel analysis 
section is the assemblage of wall & beam sections. 

Design Section 

The section utilized for design as per pier / spandrel definition. The different types of design 
sections detailed below; 

Uniform Reinforcing section Planar I Three dimensional Designed & 
Checked 

... General Reinforcing section Planar I Three dimensional Designed & . ! 
Q. Checked 

Simplified pier section Planar Designed 

! Spandrel design section Planar Designed 
" c • D-
en 

Uniform Reinforcing Section 

Uniform reinforcing section is applicable to both planar & coupled shear walls. 

For flexural design/check, the geometry is picked up automatically by the program from the area 
objects that define the pier section. 
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For shear / boundary zone checks, the program automatically (and internally) breaks the analysis 
section pier up into planar legs and then performs the design on each leg separately and reports 
the results separately for each leg. 

The planar legs are derived from the area objects that defined in the model only. 

In this process, section will be designed / checked for uniform reinforcing. 

General Reinforcing Section 

This section is defined using the section designer utility in ETABS module. User can create any 
geometric shape as in architectural drawings. User can vary vertical rebar diameter and spacing 
and details. 

Simplified Pier Section 

This is applicable to planar walls only. Using this design section, user can only design the walls. 

Section design (or) Middle strip 

Edge design (or) Edge strip 

Material design property definition 

l D"~~~ 
Naterial Name lim 

L_. 
Type of Material 

I 
[ Type of Dos9n---

I Concrete iJ I r. Iwbopjc r OrthotJopic Detlgn 

Anofy,i, Plop.rty Dot. DeSign Property 0.t.1858110 57) 

1 
Mass per unit Volume 12.5 Cone Cube Camp Slrengt~ feu 127579. 

Weig ..... per uni Vaume 124.5 Bendirg Reinf. Yiekt Stless, fy 1413685. 

Modulus 01 EJas1i~ 13OOJOOlO Sh ... Reid Yield She .. fy. 1413685. 

Poi$$on', A~tio 102 r Lightweight Concrete 

Coeff of Thermal Expansion 1990[£.06 She .. >~OfIgth Reduc Fecto< I 
Shear Modu!u. 11 2500000. 

Cancfl I 

Preferences: 

Wall Pier/Spandrel Design Preferences 

D.,.;g, Code 858110.97 
Tine Hio~ Oeaian Envelopes 
Rebar Units mm"2 
Rebarll..ngth Unit. mm"2lm 
Garrma(5~ 1.05 
G/!11111!1 (Gonaet_) 1.5 
G/!11111!1 (Gonaet. Shear) 1.25 
Numbe< of Curves 24 
Numbe< of Point; 11 
Edoe D...v. PT -Max 0.06 
EdgeJ)~ PC-M .. 0..04 
Section D...v. IP-Max 0..02 
Section DeoQ11P-Min 0..0025 
Utizalion Factor Limit 0..95 
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In the Options menu> Preferences> Shear wall design, the design code will be set as BS 8110 
97 code with the default design parameters. 

Edge Design PT - Max & PC - Max indicates the limiting percentage of rebar requirement at the 
edge strip if the section is being designed as simplified T & C method . 

Section Design IP - Max & Min - This indicates the percentage of maximum and minimum rebar 
requirement at the wall section (applicable to user defined pier section or uniform reinforcing 
option). 

9.1.3 Wall Pier Flexural Design 

Checking of a wall design section 

When the wall section is specified to check for the given rebar details, the program creates an 
interaction surface for that pier in three dimensional space at 15 degree intervals (by default) to 
determine the flexural demand/capacity ratio for that pier. 

The required number of degree intervals of interaction surface can be overwritten in the 
preferences and it is recommended to be 24 or more with number of points required to make an 
each curve as 11 or more but this needs to be in odd number. 

Pr 

/' 
,;' 

~ Vc 
V .( \ I P 

~ V / 
AXI() 

~ / V 
/' 

Con pressi .......... 
Axi~ ~ ~ V- Ma M3r 
Ten ,ion 

Two- dimensional Wall Pier Demand / Capacity Ratio 

Designing of a wall design section 

When the pier section is to be designed, the program creates a series of interaction surfaces for 
the pier based on the following factors; 

a) The size of the pier as specified in section designer 
b) The location of the reinforcing specified in Section Designer. 
c) The size of each reinforcing bar specified in Section Designer relative to the size of the 

other bars. 

The interaction surfaces are developed for 8 different ratios of reinforcing steel area to pier area, 
which spans between the maximum and minimum ratios as specified in preferences. These 
limiting ratios can be overwritten in the preferences. 
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9. 1.4 Wall Pier Shear Design 

Wall pier shear design is performed at top and bottom of pier section. ET ABS follows the 
procedure as per BS 8110, CI. No. 3.4.5. 

Concrete shear stress is limited to avoid shear cracking prior to the ultimate limit state, hence the 
shear stress is limited to equation 6b in the code. 

In the calculation of concrete shear stress, the area of tension reinforcement is considered as 
50% of the total area required for the pier section. 

The maximum shear stress is limited to 5 MPa and it doesn't consider any enhancement due to 
high strength concrete. 

The minimum shear steel i.e. horizontal steel is reported for the shear stress is equal to 0.4MPa. 

During the shear design process, the reduction in concrete shear capacity will be considered due 
to axial tension. 

Uniform Reinforcing section 

This wall design section will have uniform reinforcing (Edge bar & End bar) throughout the 
section. This wall section is applicable to two and three dimension shear wall systems. ETABS 
allows us to check & design for the user defined rebars details. 

The planar pier sections with uniform reinforcing are designed for major axis moment and the 
minor axis moment i.e. out of plane moment is always ignored. 

The geometry of a uniform reinforcing pier section is picked up automatically by the program from 
the area objects that define the pier section. If the pier section is made up of line objects only, the 
line objects are considered by the program when determining the pier geometry. 

•••••••••••• i ......... : .. 
i 

Plan View of Wal~ Pier 

Edge bar 

c=J 

Pier section Top Pier section Bottom 

View of objects as modelled in ETABS 
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L 

Section @ top 

J 

] 

,I 

o 

o 
II 

Section @ bottom 

View of pier section in Section Designer (Flexural Check) 

The above picture shows the uniform pier section automatically assumed by the ETABS design 
module for the flexural design check. 

Leg 2 

Leg 4 

The pier is broken up into four legs labelled Leg 1 
through Leg 4. The shear design and boundary zone 
check are performed separately for each leg based 
on the forces in the leg. This automatically accounts 
for torsion in 3D wall piers. 

View of pier section for shear design check 

User needs to select the "Uniform Reinforcing" option in the Pier section type in the above form. 

Un;(orm Reinforcing Pier Section - Design (8S8110 97) 

Storg 10: STORY3 Pier ID: P1 X Loc: 9 Y Loe: 12 Units: KN-m 

FleKlnl Design for P-ht2-ht3 (RLLF = 1_000) 
Station Required Current FlellUral Pier 

Location Reinf Ratio Reinf Ratio Combo P 1012 ht3 Ag 
Top 0.0025 0.0028 COMBl 15000.000 0.000 0.000 0.500 

Bottom 0.0025 0.0028 COMBl 15000.000 0.000 0.000 0.500 

Shear Design For V2 
Station Rebar Shear Capacity Capacilg 

Location mmA 2Jm Combo P N V Vc Va 
Top Legl 228.833 COMBl 15000.000 0.000 0.000 1922.744 200.000 
Bot Leg 1 228.833 COMBl 15000.000 0.000 0.000 1922.744 200.000 

The required flexural reinforcing ratio & horizontal shear reinforcing will reported for the governing 
design load combination. 

Uniform Reinforcing Pier Section - Check (8S8110 97) 

Storg ID: STORY2 Pier 10: P1 X Loc: 9 Y Loc: 12 Units: KN-m 

FleKural Check f (RLLF = 1_000) 
Station Flexural 

Location Combo P ht2 ht3 
Top COMBl 15000.000 0.000 0.000 

Bottom COMBl 15000.000 0.000 0.000 

Shear Design For V2 
Station Rebar Shear Capacit, Capacit, 

Location mmA 2Jm Combo P ht V Vc Vs 
Top Leg 1 228.833 COMBl 15000.000 0.000 0.000 1922.744 200.000 
Bot Leg 1 228.833 COMBl 15000.000 0.000 0.000 1922.744 200.000 
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The same uniform pier section will be checked. The demand / capacity ratio & required shear 
reinforcing will be reported. Shear strength can't be checked against the provided horizontal 
shear steel. 

Pier Design Overwrites - Uniform Reinforci 

o 
o 
o 
o 
o o 
o 
o 
o 

Design this Pier? 
LL Reduction Factor 
Pier Section Type 
End/Corner Bar Name 
Edge Bar Name 
Edge Bar Spacing 
Clear Cover 
Ml!!lerial 
Check/Design Reinforcing 

Yes 
1. 

Uniform Reinforcing 
10d 
10d 
0.25 

0.0313 
CONC 
Design 

OK 

Cancel 

In the above pier design overwrite form; user can define rebar diameter and spacing, material and 
live load reduction factor (Minimum 0.5 as per BS). 

General Reinforcing section 

The concept for this design section is same as uniform reinforcing section with user defined 
reinforcing using section designer in ETABS. Here the user defines the geometry of the pier 
section and the size and location of vertical rebar. 

Shear design will be performed same as uniform reinforcing section. 

Define the general reinforcing section using the Design menu> Shear Wall Design> Define 
Pier Sections for Checking. 

Base material type needs to be defined at this stage, which can't be revised in the design 
overwrites form later. 

Seclions 

PSECl 
PSEC10 
PSECll 
PSEC2 
PSEC3 
PSEC4 
PSEC5 
PSEC6 
PSEC7 
PSEC8 
PSEC9 

C_liC_k 1_0: Add......:.....;,Pie-,' S;;,,:e_clron....;,,:; ... _.....11 I 
Add Copy 01 Pie, Seclion. 

Delete Pier Seclion 

OK Cancel 

SectiDn Name I~ 

Base Mate,ial IC40 3 
Add Pier 

r. Add New Pie, Section 

r St~'tl,omE",.tingW~I1Pie, 

DefinelEditlShow Section 

S eclion Designe, .. 

Cancel I 

Add the pier section using the Add Pier Section ... Option, Pier section will be added as a new 
section or start from existing wall pier. 
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Assign the general reinforcing pier section to the existing wall pier using the Design menu> 
Shear Wall Design> Assign Pier Sections for Checking ... >General Reinforcing Pier 
Section 

User defined pier section will be possible to assign at bottom and top of pier section with the 
option of design or checking. 

Pier Sectiono 

Section at Bottom ,. 
NONE 
PSECl 
PSEC10 
PSECll 
PSEC2 
PSEC3 
PSEC4 
PSEC5 
PSECS 

ChecklDesign 

Secti..., at Top 

NONE 
PSECl 
PSEC10 
PSECll 
PSEC2 
PSEC3 
PSEC4 
PSEC5 
PSECS 

co Rm",coment to be Checked 

r ReinfOicement to be Designed 

User defined section will be checked for the user defined reinforcing pattern. The program will 
report the demand I capacity ratio and required shear reinforcing for the governing load 
combination. 

If there is a three dimensional wall system, the shear design will be reported to the first 
inadequate leg or Leg requiring most rebar per unit length. 

SIOf,ID: lOl Pier 10: P10 X lac: 16.475 Y loc: 11 .5 Unila: KN ·m 

Flexural Check 'Of P-M2-M3 
Slation DIC 

location Ralio 
Top 0.602 

B attom 0.701 

(RllF -1.000) 
Flexural 
Combo P 

ULTENV 137973.600 
ULTENV 136300.534 

M2 
11957.388 
11502.300 

M3 
19615.910 
16919.518 

Shear Deaign FOf V2 - Firat Inadequate leg or leg Requiring Moel Rebar per Unit length 
Station Rebar Shear Capacit, 

location mmA 2/m Combo P M V Vc 
Top Leg 2 274.600 ULTENV 11008.705 3233.422 236.400 4367.618 
Bot Leg 1 274.600 ULTENV 1661 .322 22.977 104.497 846.059 

Capacity 
Ve 

912.000 
133.200 

The pier section can also be designed using this option but it reports the required reinforcing ratio 
assuming uniform reinforcing pattern. 

Slor,ID: lO1 Pier 10: P10 X loc: 16.475 Y loc: 11.5 Unite: KN-m 

Flexural Deeign for P-M2-M3 
Station Required 

location Reinf Ratio 
Top 0.0059 

Bottom 0.0159 

(RllF K 1.000) 
CUllent Flexural 

Reinf Ratio Combo 
0.0336 ULTENV 
0.0346 ULTENV 

P 
137973.600 
136300.534 

M2 
11957.388 
11502.300 

1013 
19615.910 
16919.518 

Shear Design For V2 - Firsl Inadequate leg 01 leg Requiring Mosl Rebar per Unit length 
Slation Rebar Shear Capacit, 

location mmA 2/m Combo P 101 V Vc 
Top Leg 2 274.600 ULTENV 11008.705 3233.422 236.406 4367.618 
Bot Leg 1 274.600 ULTENV 1661.322 22.977 104.497 846.059 
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Simplified C & T Pier section 

The pier geometry is defined by a length, thickness and size of the edge members at each end of 
the pier (if any). 

tP~~p rt;~ 
M,•p 

t 
<I> 
E 
<I> 
Ol 

"C 
Qj 

= <I> .... 

lp~.~ ~M~I 
P~ 

Wall ~i!![ ~levil!ioD 

I I B'·'EL I 
I ... 
~ 

W.1I Pier PiAn 

tPoJ1l~ 
Top of 
pier 

: ~ 
.0 
E 

. CJ> 

. E 
: <1> 
: C> 

' a! 
E 
C> a: 

Bottom l of~& 
PtVll-bol 

I I I~ 

8 2 . .. 

B *4
B" ... 

1 I 

" 
ly L. 

1 'I 
Plan 

Typical Wall Pier 

Nole: The dimensions shown 
may be different at the bottom 
of waD and the top of wall 

ilc .s>~ 
; LJ/l 

¥"? ~ 
D~ 

Typical Wall Pier 
with Edge Members 

Assign the simplified pier section to the existing wall pier using the Design menu> Shear Wall 
Design> Assign Pier Sections for Checking ... > Simplified C and T Section 

Perform the simplified C & T section design using the Design menu> Shear Wall Design> 
Start Design I Check of Structure 

The pier section flexural design will be performed to edge strip of pier section and it ignores the 
resistance from the middle strip. 

Program will report the required width of edge strip to resist the axial and over turning moment 
and required reinforcing in the governing compression and tension load combination. 

Program will perform shear design by considering the full length of the pier section and reports 
the required shear reinforcing per unit length for the governing load case. 
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Simplified T and C Pier Section - Design (BS8110 97) 

Stor,lO: STORY" Pier 10: Pl X Loc: 9 V Loc: 12 Units: KN-m 

FleKural Design for P and M3 
Slation 

(RLLF = 1.000) 
T enlion T enlion 

Location Edge-Length 
Left Top O. B75 

RightT op 0.B75 
Left Bottom 0.875 

Right Bottom 0.875 

Slation 
Location Edge-Length 

Left Top 0.875 
Right Top 0.875 

Left Bottom 0.875 
Right Bottom 0.875 

Shear Delign For V2 
Slation Rebar 

Location mm A2/m 
Top 228.833 

Bottom 228.833 

Limitations: 

Rebar mmA 2 Combo 
0.000 COMBl 
0.000 COMBl 
0.000 COMBl 
0.000 COMBl 

Comprellion Co.prealion 
Rebar mmA 2 Combo 

6232.150 COMBl 
6232.150 COMBl 
6232.150 COMBl 
6232.150 COMBl 

Shear 
Combo 
COMBl 
COMBl 

P 
15000.000 
15000.000 

P 
15000.000 
15000.000 
15000.000 
15000.000 

P 
15000.000 
15000.000 
15000.000 
15000.000 

M 
0.000 
0.000 

In planar walls, the minor axis moment effect will be ignored. 

lot 
0.000 
0.000 
0.000 
0.000 

lot 
0.000 
0.000 
0.000 
0.000 

v 
0.000 
0.000 

Capacity 
Vc 

1727.494 
1727.494 

Capacit}l 
V, 

200.000 
200.000 

Effects resulting from warping stresses i.e. torsion will be ignored. (wall with numerous 
opening) 

Assumes that the members with shear reinforcement providing a design shear of 
0.4 N/mm2. 

Shear stress is not limited to the requirement of high strength concrete. (I.e. fcu > 55 MPa) 
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9.2 Reinforced Concrete Frame Design (as 8110-97) 

Preferences: 

To view preferences, select the Options menu> Preferences> Concrete Frame Design 
command 

Concrete Frame Design Preferences 
Material strength factors I I 

Design Code 85811097 IV Time History Design Envelopes 
Number of Interaction Curves 24 
Number of Interaction Points 11 
Consider Minimum Eccentricity ~ ../' 
Gamma (Steel) ( 1.05 \ 
Gamma (Concrete) l 1.5 I 
Gamma (Concrete Shear) \l.2§/ 
Pattern Live Load Factor 0.75 
Utilization Factor Limit 0.95 

Overview 

In the design of concrete beams, the program calculates and reports the required areas of steel 
for flexure and shear based upon the factored beam moments and shears. The reinforcement 
requirements are calculated at a user-defined number of check stations along the beam span. 

It is assumed that the design ultimate axial force does not exceed 0.1 fcu Ag (BS 3.4.4.1); hence, 
all the beams are designed for major direction flexure and shear only. 

Limitations: 

1) Effects resulting from axial forces, minor direction bending and torsion will be ignored. 

2) Assumes that the members with shear reinforcement providing a design shear of 
0.4 N/mm2. (Minimum shear links) 

3) Shear stress is not limited to the requirement of high strength concrete. (Le. fcu > 55 MPa) 

4) This design module helps only in the preliminary sizing of beam members. (major flexure & 
shear) 

5) Limit state of serviceability of beams are not determined (deflection, crack width). 
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